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1 Introduction

Acoustica is a universal audio editing program that offers a large range of high quality

audio tools and effects. The improved audio editing engine allows unlimited undo and

redo levels, ultra fast non-destructive editing and 24 or 32 bit editing with up to 192 kHz

sampling rate. You can import tracks from audio CDs and create audio CDs with your

edited material without leaving the program.

Acoustica has user friendly and versatile tools for quality enhancement of old LP or tape

recordings. Remove stationary noise like tape hiss or let Acoustica add high frequency

harmonics to dull recordings. You can alter the timbre of your sound in almost any way

possible with the six band full parametric equalizer or choose from a large number of

audio effects ranging from lush reverbs to high quality time stretching. If this is not

enough, the support for DirectX plug-ins makes it easy to extend the program with third

party audio processing tools.

1.1 What is new in Acoustica 3.3

The new version 3.3 contains several new features for both the ambitioned and the less

experienced user. Users new to audio editing will welcome the new Cleaning Wizard

that simplifies the transfer of LP records or audio tapes to CDs. The Cleaning Wizard

automates the whole process from recording and track splitting to audio restoration and

CD recording.

The new effect chain editor in version 3.3 allows the user to chain internal processing

tools and plug-ins. The chains can be saved including their settings for later use. Each

processing step in the chain can be bypassed and the processing order changed by drag

and drop.

New Features

· Effect chains

· New Cleaning Wizard simplifies LP or tape to CD transfers

· Dithering and noise shaping

· Statistics (RMS, DC offsets, loudest peak and more)

· New stereo enhancer tool

· Support for ACID information in wave files

· New time formats such as sample index, SMPTE and bars and beats

· Preview button in the file open dialog

· Regions can be saved as separate files

· Support for the LAME codec if installed

· Several new usability features
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1.2 Requirements

Before you install Acoustica, please make sure your computer fulfills the following

requirements:

· A Pentium or compatible processor with at clock rate of 350 MHz or more

· Minimum 64 MB RAM

· A Windows compatible sound card

In addition, you will need the following software installed on your computer:

· Windows 98 SE, Windows ME, Windows 2000 or Windows XP

· DirectX 8.0 or later

· Windows Media Player 10 is required for mp3 export with a bit rate higher than 56

kbit / s

2 Basic Audio Editing

This chapter describes the basic audio editing capabilities of Acoustica such as loading

and saving files and editing using the clipboard or drag and drop.
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2.1 The Acoustica Workspace

The Acoustica workspace can contain several audio editing windows or CD projects.

The Acoustica workspace

The figure above shows the Acoustica workspace with an audio editing window and a

CD project. The elements indicated with the red arrows are explained below:

1. The main toolbar with short cut icons for commonly used commands.

2. The navigation toolbar for recording, playback and cursor positioning.

3. An audio editing window containing the audio file "Matecha.wav". The audio is

visualized with a curve corresponding to the recorded audio (see Time Domain).

4. A selected region indicated with white curve on a blue background (colors depend

on your system settings). The current cursor position is indicated by a blinking line.

5. The status bar indicating the selected region, the viewed region and the cursor

position. During processing, the progress is displayed in the status bar.

6. The output level meters show the current output level during audio playback.

7. A "CD project" window containing a list of tracks and a toolbar for commands

relevant to CD recording.
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8. The list of CD tracks that are about to be recorded to an audio CD.

2.2 Loading Audio Files

To open existing audio file,

1. Select from the File menu the command Open...

2. Choose the folder in which your file is located from the Look in drop-down list.

3. Click the audio file you wish to open and click the button labelled Ok.

2.3 Saving Audio Files

To save an edited audio file with its original name:

1. Select from the File menu the command Save or press Ctrl+S.

If you wish to save the content of an audio editing window with a different name, in a

different folder or with different settings:

1. Select from the File menu the command Save as...

2. Choose the folder in which you wish to save the file from the Look in drop-down list.

3. Enter a name for your audio file.

4. Choose the file format of your audio file from the File type drop-down list.

5. Most export filters offer different settings such as encoding bit rate or number

format. To change the settings, click the button labelled Options... .

2.4 Playing a Recording

To play the selected region of a recording:

1. Select from the Sound menu the command Play or press the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

You can also play the complete recording:

1. Select from the Sound menu the command Play all or hold the shift key while

pressing the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.
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To play the selected region as a loop:

1. Select from the Sound menu the command Play looped or hold the control key while

pressing the space bar.

2. You can stop the playback by selecting from the Sound menu the command Stop or

by pressing the space bar.

Alternatively, you can use the navigation toolbar for convenient playback:

The navigation toolbar with the logic similar to consumer audio equipment such as CD players or

tape decks.

2.5 Selecting Regions

Acoustica does all processing on the selected region and the selected channels only. The

selected region is highlighted. To change the selected region:

1. Click the beginning of the region you wish to select and keep the mouse button

down.

2. Move the mouse cursor to the end of the region you wish to select while keeping the

mouse button down.

3. Release the mouse button.

4. The newly selected region should now by highlighted.

2.6 Selecting Channels

Acoustica does all processing only on the selected region and the selected channels. To

change the selected channel or channels (only possible with stereo recordings):

1. Click the channel selection button in the main toolbar (see

The Acoustica Workspace): 

2. A drop-down list with the channels appears.

3. Click the channel you wish to activate or deactivate.

2.7 Zooming and Scrolling

You can zoom in to get a more detailed view in an editing window. You can zoom both

horizontally to view a smaller part of the recording or vertically to show a smaller

amplitude range.
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Horizantal zoom

To zoom in horizontally:

· Press the arrow up key

- or -

· Move the mouse wheel upwards

To zoom out for a better overview:

· Press the arrow down key

- or -

· Move the mouse wheel downwards

Note

You can zoom out to view the whole recording by selecting View | View all or by

pressing Shift + A.

Scrolling

In those cases where only a part of the recording is shown, a scroll bar is visible below

the visualisation of the wave form. You can use the scroll bar to view other parts of the

recording.

Vertical zoom

To zoom in vertically:

· Press and hold the control key while pressing the arrow up key

To zoom out vertically:

· Press and hold the control key while pressing the arrow down key

You can also enter the zoom factor in the toolbar and press the enter key:
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2.8 Drag and Drop Editing

You can move or copy regions using so-called drag and drop editing. To move a region

to a another location in the same editing window or to another editing window:

1. Select the region you wish to move (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Shift key while moving the mouse cursor to the new start position and

release the mouse button.

To insert a copy of a region using drag and drop:

1. Select the region you wish to copy (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Ctrl key while moving the mouse cursor to the insert position and release

the mouse button.

To mix two regions using drag and drop:

1. Select the first of the regions you wish to mix (see Selecting Regions).

2. Click the somewhere within the highlighted region and keep the mouse button

down.

3. Press the Alt key while moving the mouse cursor to the start position and release the

mouse button.

Note

If you press neither the Ctrl key nor the Shift key during drag and drop, Acoustica

will perform the default action which is a move operation if the drop destination is

the same editing window and a copy operation if the drop destination is another

editing window.

2.9 Editing using the Clipboard

The clipboard concept provides a common way of editing documents for all Windows

applications. You can edit your recordings by copying the selected region to the

Acoustica clipboard using the command Edit | Copy and paste the region into another

location using the command Edit | Paste Insert. The Paste Insert command is equivalent to

the normal paste command common in most Window applications. Acoustica has offers

two additional ways of pasting:

· Paste Overwrite, which substitutes a selected region with the content of the
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clipboard.

· Paste Mix, which mixes the selected region with the content of the clipboard.

The command Edit | Cut copies the selected region to the clipboard before deleting it

from the source recording. For the purpose of deleting parts of the recording, use one of

the following two commands:

· Delete, which deletes the selected region

· Crop, which deletes everything but the selected region.

2.10 Audio Scrubbing

Sometimes it is hard to find a specific part of a recording using the visualization only.

The audio scrub mode simplifies the search by giving aural feedback while you can

move the playback position using the mouse. To use the audio scrubbing:

1. Enable the audio scrubbing mode clicking the audio scrubbing symbol in the toolbar

(  ) or by pressing A.

2. Click the left mouse button and keep it down while moving the mouse cursor

3. Release the mouse button when you have found the part you were searching for.

4. Enable the selection mode by clicking the selection mode symbol in the toolbar (  )

or by pressing S.

2.11 Labels and Regions

You can simplify the editing process by inserting anchors such as labels and regions to

your recording.

Adding Labels

To add a label to the recording:

1. Move the cursor position to where you want the to insert a label

2. Click the right mouse button and select "Add Label..." or press L.

3. A label appears at the cursor position

Adding Region Markers

To add a region marker to the recording:

1. Select the part of the recording where you want a region marker

2. Click the right mouse button and select "Add Region..." or press R.
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3. A region is appears at the selection

Renaming, Moving and Deleting Anchors

You can easily rename anchors:

1. Double click the anchor text

2. A properties dialog box appears.

3. Enter the new name of the anchor.

4. Click the button labelled OK.

You can also move the anchors:

1. Click the left mouse button at the upper part of red line visualizing the anchor.

2. Keep the mouse button down while moving the anchor to its new position

3. Release the mouse button.

To delete an anchor:

1. Click the right mouse button at the anchor text

2. A context menu appears.

3. Select "Delete"

The Label and Region List Windows

You can edit and keep track of your anchors by showing the region list and label list

windows. To show the label list window, select "Label List" from the View menu. The

menu item "Region List" from the same menu shows the region list.

The Region and Label List windows make it easy to edit and keep track of the anchors.

3 Recording

Recording audio in Acoustica is easy, but there are some terms you should know before

starting you first recording project. The chapter Concepts of Digital Audio theoretically

describes some important issues regarding digital audio. If you are familiar with digital
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audio, please proceed to Recording through the Sound Card.

3.1 Concepts of Digital Audio

Before audio can be edited on computers it must be digitized. The output from most

audio equipment such as tape recorders, microphones or record players is analog.

Analog means that the audio signal is represented by an alternating electrical voltage.

The voltage is analog to the air pressure changes in the air during the performance,

hence the term analog signals. The sound card in your computer is needed to convert the

constantly changing electrical voltage to a stream of numbers at fixed rate intervals.  This

process is done in two steps called sampling and quantisation.

3.1.1 Sampling

The conversion from a continuously changing measure to a series of measured values at

discrete time instances is called sampling. The rate (or number of measurements per

second) of which the sampling is done, is along with the quantisation depth the most

important quality factor of digital recording equipment. If it is set too low, disturbing

artifacts occur. A CD quality recording is recorded with a sampling rate of 44 100

samples per second. We say that the sampling frequency is 44 100 Hertz (or short Hz).

In fact, all frequencies above half the sampling frequency, which is known as the

Nyquist frequency, are substituted by frequencies below the Nyquist frequency. This

effect is called aliasing. To avoid aliasing a sampling system contains of a low pass filter

which ideally filters out all frequencies above the Nyquist frequency and leaves all

frequencies below unaffected. In the case of the audio CD, the highest frequency that can

theoretically be recorded is 22 050 Hz.

3.1.2 Quantisation

After measuring an analog input signal at fixed time intervals we have a stream of

samples. The samples exist in terms of a voltage measured at a certain point in time. The

voltage can usually be one of an infinite number of possible voltages within the legal

voltage range. Computers cannot accurately describe every single one of the infinite

number of possibilities, so it is necessary to divide the voltage range of interest into fixed

sized regions. All voltages within one region are given a certain number during the

quantisation process. If we have a large number of regions which implies a larger

number of discrete voltage levels, we can describe a voltage more accurately than with

fewer voltage levels. The audio CD is quantasized with 65536 voltage levels, which is the

maximum number of levels possible to archive with a binary number with 16 bits. Thus

we say that the Audio CD has 16 bit resolution. Modern recording studios are frequently

using 24 bit resolution or even higher during the mastering process.
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The digital representation of a sine wave.

3.1.3 The Decibel Unit (dB)

When the volume of the recorded sound is changed, the degree of change is usually

expressed in terms of decibels or short dB.  This is a common unit in connection with

audio.  In Acoustica, decibel is used to express the extent of change relative to the

original level.

Special for the decibel unit is that it is based on a logarithmic scale. Zero dB represents

no change, whereas an increase of six dB represents a doubling of the signal amplitude.

Reducing by six dB results in half the signal amplitude.

 

The decibel dB versus intensity change in percent

The decibel scale is chosen to suit the sensitivity curve of the human ear which have the

same logarithmic property.

3.2 Recording through the Sound Card

To record audio from audio equipment such as record players, tape decks or

microphones through your sound card:

1. Make sure the audio source is properly connected to the audio input of your

computer. The physical layout of the audio inputs differs from computer to

computer. Please consult your computer or sound card manual for further

explanations.

2. Create a new an empty recording window by selecting File | New... or position the

cursor where you want to insert recorded audio in an existing recording.
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3. If you are recording to an empty editing window Acoustica needs to know what

sample format you wish to use (see Concepts of Digital Audio for more

information). The following dialog box appears:

The sample format dialog box in Acoustica

Please choose the desired recording format and click the button labelled Ok.

4. The Recording dialog box now opens:

The Recording dialog box
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Now make sure that the correct input line is selected in the line in combo box (1).

You can monitor the input level using the level meters (2) and, if needed, adjust the

input level using the input level slider (3). The level meter should never be in the red

area in order to avoid clipping distortions.

5. Click the button labelled Record (4) to start the recording.

6. When you are done recording, click the button labelled Keep (5) to accept the

recording.

4 Audio Processing

In Acoustica, all the processing tools have some properties in common. The processing is

performed on the selected region and the selected channels only. Furthermore, most

tools offer a preset manager that allows you to save often used parameter settings for

later use.

The Preset Manager found in most of the processing tools in Acoustica

To add a preset:

· Click the button labelled Add...

· Enter the name of the preset and click the button labelled Ok.

Loading a preset is equally simple. Just select the preset from the drop-down list and the

preset settings are loaded. User presets can be removed by clicking the button labelled

Remove... and selecting the preset you wish to remove.

You can bypass the effect processing by checking the check box labelled Bypass transform

for a convenient A / B comparison.

The processing tools introduce some custom controls that you should get familiar with.

The level slider is similar to the Windows track bar, but with some enhancements. The

value range and the current value is always displayed. You can manually edit the value

by pressing the space bar when the control is active or by clicking the value text below

the level slider. An edit box pops up containing the current value. To change the value,

enter a new value and press return. By pressing the Esc key the changes are discarded.
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Examples of level sliders and knobs.

The knob control is similar to the level slider, but it is round and is often used to save

space in complex layouts. As with the level sliders, you can change the value by pressing

the space bar or by clicking the value text below the knob.

A more complex custom control is the curve control which is used when a curve input is

needed. The curve control allows the user to add, move or remove points. Straight lines

between the points build the curve. You can add points by clicking the location where

you want a new point to appear in the curve control. You can remove points by clicking

the right mouse button over an existing point.

Examples of a curve edit control (from the noise reduction tool in Acoustica).

4.1 Manipulating Volume

The Volume menu contains several commands for manipulation the volume of a

recording.

· Adjusting the Volume

· Normalize

· Applying a Volume Curve
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· Fading In or Out

· The Channel Mixer

4.1.1 Adjusting the Volume

The most basic volume manipulation command is the Adjust Volume... command in the

Volume menu. The only parameter is the volume change in decibel. For more information

on the decibel unit,  see The Decibel Unit (dB).

The Adjust Volume settings

4.1.2 Normalize

The Normalize... command in the Volume menu can be used to ensure a constants signal

level in all your audio recordings. After selecting your desired maximum peak level

output in decibel, Acoustica analyses the selected region for the loudest peak. The

volume of the region is changed according to the selected maximum. If you set the

normalize level to 0 dB, the loudest part will be the maximum level reproducible without

signal distortion. For more information on the decibel unit, see The Decibel Unit (dB).

The Normalize dialog box

4.1.3 Applying a Volume Curve

You can apply a user drawn volume curve on the selected region by selecting Draw

Freehand Volume Curve... from the Volume menu.
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The Volume Curve settings

4.1.4 Fading In or Out

If you wish to create fade ins or fade outs, select Fades... from the Volume menu. You can

select a fade curve from one of four mathematical functions from the Fade function drop-

down list:

· Linear

· Logarithmic

· Exponential

· Sinusoidal

Select the direction of the fade using the Fade in or Fade out radio buttons. The resulting

fade curve is visualized in the curve control.
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The Volume Fade settings

4.1.5 The Channel Mixer

The channel mixer is a tool that works only on stereo recordings. The channel mixer

mixes the content of the left and the right channels with a user defined weighting. The

weightings are individually adjustable for each channel.

The Channel Mixer settings
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4.2 Audio Effects

4.2.1 Dynamic Processor

A dynamic processor is used to alter the dynamic properties of the recording. To

understand how a dynamic processor works, imagine a sound engineer trying to

maintain an as steady volume level as possible while doing a recording. When the input

level increases he pulls down the volume slider, and he pulls it up when the input level

decreases. A dynamic processor does the same thing automatically, only with a much

faster reaction time.

The Dynamic Processor settings

Settings

· An editable curve containing the output level as a function of the input level. By

altering this curve you can change the dynamic characteristics of the recording to fit

your needs.

· Attack time

The reaction time when the input level of the source material increases.
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· Release time

The reaction time when the input level of the source material decreases.

4.2.2 Delay

The delay effect adds delays or echoes to the selected region.

The Delay settings

Settings

· Delay time

· Feedback

The feedback percentage specifies the volume attenuation since the last delay

interval.

· Dry Level

The amount of unprocessed signal in the output mix.

· Delay Level

The amount of processed signal in the output mix.
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4.2.3 Reverb

The reverb simulates the reverberation effect of some natural surroundings.

The Reverb settings

Settings

· Reverb program

Select the reverberation program from the drop-down list that fit you needs. You can

choose between Small room, Medium room, Large room, Concert Hall 1, Concert Hall 2,

Cathedral, Stadion or Plate reverb. Only the Plate reverb needs further explanation.

The plate reverb program simulates the sound of analog plate reverbs used

frequently before digital reverbs were available.

· Reverberation time

The time before the reverb tail drops below 1 / 1000 of its original amplitude.

· Reverb level

The amount of processed signal in the output mix.

· Dry out level

The amount of unprocessed signal in the output mix.

4.2.4 Flanger

Flanger is an artificial effect. Flanger will occur when two sources playing the exactly

same recording with a short time delay are mixed together.  The result is that some

frequencies are canceled, while others are amplified. Changing the time delay between

the two sources will result in other frequencies being canceled or amplified.



23Audio Processing

Copyright © 2003-2005 Acon Digital Media GmbH

The Flanger settings

Settings

· Modulation depth

Amplitude of the modulating function.

· Modulation frequency

Frequency of the modulation function. A higher modulation frequency will result in

faster changes in the tone quality.

· Feedback

The feedback percentage specifies attenuation in the internal delayed feedback loop.

· Stereo Flanger

Toggles stereo or mono processing mode.

· Dry Level

The amount of unprocessed signal in the output mix.

· Flanger Level

The amount of processed signal in the output mix.

4.2.5 Chorus

Chorus adds warmth to recordings by dividing the audio source into several voices with

a random vibrato. These artificially created voices are then mixed together.
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The Chorus settings

Settings

· Modulation depth

Amplitude of the modulating functions.

· Modulation frequency

Frequency of the modulation functions. A higher modulation frequency will result

in faster changes in the tone quality.

· Feedback

The feedback percentage specifies attenuation in the internal feedback loop.

· Stereo Chorus

Toggles stereo or mono processing mode.

· Dry Level

The amount of unprocessed signal in the output mix.

· Chorus Level

The amount of processed signal in the output mix.

4.2.6 Harmonizer

The harmonizer mixes several pitch shifted voices to create interesting harmonies. You

can mix up to four pitch shifted voices. The often experienced "chipmunk" effect which

occurs when transposing the human voice or musical instruments can be reduced using
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the Maintain timbre option. When Maintain timbre is checked, Acoustica creates a smooth

spectral envelope estimation of the signal and whitens the signal before pitch shifting.

The original smooth spectral envelope is applied after transposing and the original

timbre is preserved.

The Harmonizer settings.

Settings

· Activate

Check this to activate the current voice.

· Interval

The musical interval to transpose. Use the radio buttons to set the transpose

direction to up or down.

· Fine tune

With this slider you can fine tune the pitch shift factor in cents which are 1/100 of a

semitone.

· Volume

Volume of the current voice in dB.

· Pan

Left / right panning of the current voice in percent.
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4.2.7 Pitch Shift

The pitch shift command allows you to transpose the content of the selected region with

or without changing its length. When pitch shifting without change of length, the

Acoustica time stretching algorithm is used to compensate for the change of length

normally occurring during pitch shifting.

The Pitch Shift settings

Settings

· Interval

The musical interval to transpose. Use the radio buttons to set the transpose

direction to up or down.

· Fine tune

With this slider you can fine tune the pitch shift factor in cents which are 1/100 of a

semitone.

· Maintain Duration

Check this check box if you want the length of the section to be the same after pitch

shifting.

· Optimize for

The inner settings of the time stretching algorithm are affected by choosing an

optimization from one of the following: Speech, Music I or Music II, monophonic signals

or percussive interments only.
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4.2.8 Time Stretching

The time stretch algorithm allows you to change the length of the recording without

changing the perceived pitch. It is not physically possible to do this without some sort of

distortion and the quality of these time correction algorithms lies in their ability to

reduce the audible distortions. Acoustica uses a method that works well on monophonic

signals like speech and single musical instruments as well as on polyphonic music.

However, some artifacts occur on high expansion or compression rates like in all other

time stretching software.

The Time Stretch settings

Settings

· Percentage

The time stretching factor in percent.

· Optimize for

The inner settings of the time stretching algorithm are affected by choosing an

optimization from one of the following: Speech, Music I or Music II, monophonic signals

or percussive interments only.

· Duration change

Here you can enter the new length after time stretching.

· Tempo change

Here you can enter the original tempo in BPM and the target tempo after time

stretching
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4.2.9 Reverse

The reverse effect processes the selected region in such a manner that it will be played

backwards.

4.3 Using DirectX Audio Plug-Ins

The DirectX plug-in standard has become a widely used standard for audio processing

plug-ins on the Windows platform. Acoustica now supports DirectX plug-ins. The menu

DirectX contains a list of the plug-ins currently installed on your computer. If you have

installed a plug-in that does not appear in the list, please refresh the plug in list (see

Refreshing the Plug-in List). Using the DirectX plug ins is as easy as using the internal

audio processing tools and you will see that the preset manager and previewing works

exactly the same way as with the internal audio processing tools.

4.3.1 Refreshing the Plug-in List

If you have installed new DirectX plug-ins on your computer that do not appear in the

DirectX menu you should refresh the menu by selecting DirectX | Refresh Plug-In List.

Acoustica then rescans the plug-ins on your computer and updates the menu.

4.4 Noise Reduction

Acoustica provides tools for removal of both stationary noise such as hiss and impulsive

noise like clicks and pops. The frequency spectrum of stationary signals remain pretty

constant over time. In other words, tape hiss, humming or other constant disturbances

are removable using the Acoustica noise reduction system. The noise reduction is based

on the spectral subtraction technique. This means that a spectrum of the noise present in

the recording is needed. Acoustica can automatically estimate the noise profile or the

spectrum of the noise can be obtained through analysis of a region containing noise only.

Alternativly, the user can define the noise profile manually.

· Automatic Noise Reduction

· Removing Noise with a Measured Profile

· Removing Noise with a User Drawn Profile

Impulsive noise on the other hand are short unpredictable noise burst. It has become

usual to define clicks as single noise bursts, whereas crackle is defined as a series of very

short clicks with low amplitude. Acoustica is able to remove impulse noise due to the

short duration of the noise bursts. Acoustica substitutes the recorded signal in the short

period of time during the click with a signal estimated using the undistorted audio

surrounding each clip.

You can remove clicks either automatically or manually:
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· Automated Click Removal

· Manual Click Removal

4.4.1 Automatic Noise Reduction

The easiest way of removing stationary noise is to use the automatic noise reduction.

Select Enhancement | Automatic Noise Reduction... Acoustica then performs a statistical

analysis of recording in order to estimate the noise profile. This process might take a

little while, depending on the length of your recording. After the analysis phase, the

noise reduction window appear:

The Noise Reduction settings. The noise profile graph contains the result of the noise analysis.

There are two parameters you can adjust:

· Reduction factor scales the noise profile obtained in the analysis phase and allows

you to remove more (positiv values) or less (negative values) noise than the analysis

algorithm detected.

· Max. attenuation allows you to adjust a maximum attenuation factor for each

frequency component. This parameter is also referred to as noise floor. By leaving a

certain noise floor, you can mask annoying artifacts from the noise reduction

algorithm.

Initially, you cannot edit the noise profile graph after the noise analysis. If you want to

edit the result:

· Click the button labelled Edit Curve
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· The number of points in the curve is reduced and you can add, move or remove the

curve points.

4.4.2 Removing Noise with a Measured Profile

If your recording contains pauses with pure noise without any other signal, the pause

can be used to create a noise profile automatically. Select Enhancement | Noise Analysis...

after selecting the region containing noise only. After the analysis phase, select

Enhancement | Noise Reduction... The result of the analysis is automatically loaded in the

profile graph.

The Noise Reduction settings. The noise profile graph contains the result of the noise analysis.

Apart from the analysis method, the noise reduction algorithm is exactly the same as

with the automatic noise reduction. Hence, the parameter settings have the same

meaning.

4.4.3 Removing Noise with a User Drawn Profile

If no pauses are available for noise analysis you can draw a noise profile by hand. Select

Enhancement | Noise Reduction. A curve editor shows up where you can manually enter a

noise profile.

Note

If you performed noise analysis in a previous editing step, you will need to reset the

curve by selecting Reset from the preset list.
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For tape hiss this method works quite well. The tape noise is more or less evenly

distributed in the spectrum, thus a flat line should to the job. Finding the right threshold

can be tricky, but after a bit of try and fail, good sounding settings should be possible to

find.

The Noise Reduction settings with a manually drawn noise profile.

4.4.4 Automated Click Removal

The declicking algorithm is specialized on removing impulsive noise such as clicks and

pops.

The Declicker settings

Settings

· Reduction

Sets the sensitivity of the click filter. Higher reduction levels result in more click
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reduction.

· Click length

The maximal length of the clicks that are to be removed.

Optionally, clicks may be removed manually by selecting one single click and using the

Interpolate command in the Enhancement menu.

4.4.5 Manual Click Removal

You can remove clicks manually be selecting the smallest region which fully includes the

complete click and then select Interpolate from the Enhancement menu or press Ctrl+I.

Acoustica substitutes the region with an estimate of the signal without the click.

Note

Interpolation is only possible on short regions. If the selected region is too long, the

Interpolate command is grayed out.

4.5 Enhancement Tools

4.5.1 Remove DC Offset

Uncalibrated recording equipment may result in a signal that is not centered around

zero as it should be. The Remove DC Offset tool (select Enhancement | Remove DC Offset)

calculates the DC offset of the selected region and subtracts the offset if necessary.

4.5.2 High Frequency Rebirth

Dull and lifeless recordings may be a result of lost high frequency content. By using the

High Frequency Rebirth tool (select Enhancement | High Frequency Rebirth...), you can add

artificially created harmonics to brighten up the recording. Note that these are merely

synthetic harmonics based on the low frequent content of the recording and this feature

can only be used give the listener the impression of stronger harmonics.
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The High Frequency Rebirth settings

Settings

· Generate above

Specifies the lower limit of the frequency band where harmonics should be

synthesized.

· Add content / Replace content

If add content is selected, the original content in the synthesis frequency band is

mixed with the synthesized harmonics. If you choose replace, Acoustica removes the

original content before adding the synthesized harmonics.

· Dry level

The amount of unprocessed signal in the output mix.

· High frequency level

The amount of processed signal in the output mix.

4.5.3 Equalizer

Acoustica features a powerful six band parametric equalizer. Unlike a graphic equalizer,

a parametric equalizer allows the user to select the center frequency of the bands. The

equalizer in Acoustica also has variable bandwidths on each band.

The center frequency is specified in Hertz. Sound characters of the different frequencies

are best discovered through experimentation. The bandwidth may be specified in octave

bands. One octave band equals the frequency range of one octave on the piano

keyboard. The bandwidth is the same parameter as the Q-factor found in some analog

equipment. A higher Q-factor represents a narrower bandwidth.
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Equalizer terminology

The lower part of the equalizer dialog box is used to display the filter response curve

(gain versus frequency). The filter response curve is calculated mathematically and is

updated as the parameters are altered.

The Equalizer settings

Settings

· Frequency response

The frequency response of the current equalizer settings is visualized. Each band is

visualized with a small circle with the number of the band. The currently active

band is highlighted. You can activate band by clicking the circles representing each

band. If you keep the mouse button down while moving the mouse cursor, you can

change the gain and the center frequency of each band directly in the frequency

response.
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· Frequency

· Gain

· Bandwidth

4.6 Converting the Sample Format

You can change the sample format of an audio recording by selecting Sound | Convert

Sample Format... If you are not familiar with the terms sample rate or resolution, please

read Concepts of Digital Audio before proceeding.

To convert the sample format of a recording, select Sound | Convert Sample Format... A

dialog box appears where you can define the sample rate, resolution and the number of

channels in the new sample format. Click the button labelled Ok when you are done.

The Convert Sample Format dialog box

4.7 Effect Chains

The effect chain editor allows you to link effects, processing tools and DirectX plug-ins.

The chains can be saved including the settings of the effects for later use. Furthermore,

each element can easily be bypassed and the order of the elements changed using drag

and drop.
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The effect chain editor in Acoustica.

Adding Effects to the Chain

To add a new effect to the chain, click the add effect button [ ]. A browser window

appears where you can select the effect, plug-in or processing tool you want to add to

the chain.

Removing Effects from the Chain

To remove an effect, select the effect you wish to remove and click the remove button [

 ].

Editing the Effect Settings of an Element in the Chain

To open the effect settings window of an element in the chain, double click its entry in

the list.

Playing the Audio Processed by the Effect Chain

You can play audio processed by the effect chain if you have an open editing window.

Select the region you want to play in the editing window and click the play button [  ].

The selection will be played looped. You can stop the playback by clicking the stop

button [  ].

Bypassing an Element

You can bypass an element by clicking the checkmark left to the effect entry in the list.

Saving and Loading Effect Chains

You can store a complete effect chain including all parameter settings for later use. To

store the effect chain, click the save button [  ]. A standard file save dialog box appears,

where you can enter the file name. To open an effect, click the load chain button [  ]

and select the file in the file browser.
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5 Working with Audio CDs

You can create Audio CDs (see Creating Audio CDs) that you can play in normal CD

players directly within Acoustica if you have a supported CD burner. Furthermore,

Acoustica allows you to import audio tracks from existing CDs digitally and without

quality loss for further editing or archiving on the computer (see

Importing Audio Tracks from CDs).

5.1 Creating Audio CDs

Acoustica allows you to create audio CDs containing your edited recordings. The first

step towards your own CD is to create a CD-Project by selecting File | New | CD

Project… or by clicking the new button and select CD Project… from the drop-down list.

The CD Project contains a list of the audio tracks to be written on the CD and an

additional toolbar for commands related to the CD Project.

An empty CD Project window

The CD Project window contains a list of the audio tracks to be written to the audio CD.

You can add either

· existing audio files - or -

· the content of an editing window

as a separate tracks in the track list of the CD project.

5.1.1 Adding an Existing Audio File

You can add an existing audio file to the CD project by clicking the import audio file

button (  ) or using drag and drop from the Windows Explorer. If you click the import

button, a standard file open dialog box appears (see Loading Audio Files) where you can
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selected the audio file or files you wish to add to the CD project.

5.1.2 Adding the Content of an Editing Window

The content, or parts of the content, of an editing window can be added as a track in the

CD project without first creating an audio file:

1. Select the region in the editing window you wish to add as an audio track on the CD.

2. Click the left mouse button anywhere on the highlighted area and keep the mouse

button down.

3. Move the mouse cursor to the track list in the CD project window.

4. Release the mouse button.

Adding the selected region of an editing window to the CD project using drag and drop

5.2 Importing Audio Tracks from CDs

It is possible to digitally import audio data from audio CDs with most CD-ROM readers.

To import one or more audio tracks:

1. Select Import Tracks from Audio CD... from the File menu. The CD Track Extraction

dialog box appears.

2. Choose the device that contains your source audio CD from the CD-ROM Device

drop-down list.

3. Select the track or the tracks you wish to import from the track list.

4. Click the button labelled Extract.
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The CD Track Extraction dialog box

The imported audio tracks appears as separate editing windows in the Acoustica

workspace.

Note

You can listen to the content of a track by clicking the button labelled Preview

6 Audio Analysis

Acoustica features a range of tools that allows you to study your recorded material in the

time domain (see Time Domain), frequency domain (see Frequency Domain) or a

combination of these (see Combining Time and Frequency).

6.1 Time Domain

The normal wave plot shown when making a recording in Acoustica is a time domain

representation of the signal. When recording, Acoustica has taken samples of the signal

at certain intervals, quantasized them, and stored them as series of digitized values. The

wave plot is the result of drawing these samples on the screen with the time evolving

along the horizontal axis.
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A plot of a signal represented in the time domain

6.2 Frequency Domain

All natural sounds can be described as an infinite sum of sine functions. The frequency

of a sine function is related to what we sense as pitch. Our ears are not able to hear

frequencies above 20kHz (a sine function with 20 thousand completed wavelengths

within one second), so the mentioned infinite sum turns into a finite sum which is

possible to handle on a computer. The signal in the frequency domain is represented

through the weight of each sine function needed to recreate the signal, rather than the

sampled values from the time series. These weights are visualized in Acoustica by

selecting Analysis | Spectrum Analyzer.

 A plot of a signal represented in the frequency domain.
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6.3 Combining Time and Frequency

We have a tool for examining the frequency content (the spectrum) of our recording and

we have the normal wave plots for examining how our recording evolves over time. Is

there a possibility to combine these features, in order to study how the frequency content

evolves over a period of time? Actually, Acoustica features two ways of displaying so

called time-frequency plots. The spectrogram and the wavelet transform (based on the

Morlet class of wavelets for the advanced reader). They differ mainly in the frequency

scale. The spectrogram has a linear frequency scale whereas the wavelet transform has a

logarithmic frequency scale.

A spectrogram generated by Acoustica. The vertical axis represents the frequency, the horizontal

represents time.

You can adjust the resolution and the color representation in both the spectrogram and

the wavelet transform in the Preferences dialog box (see Changing the Preferences).

7 Preferences and Device Settings

7.1 Device Settings

Window's multimedia system allows several different audio cards being installed at the

same time. You can select which sound card to use by selecting Device Settings... from the

Options menu. Choose input and output devices from the drop-down lists in the device

settings dialog to change the current configuration and click the button labelled Ok.

7.2 Changing the Preferences

You can set your personal preferences with the command Preferences... in the Options

menu.
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The Preferences dialog box

The preferences are organized in different pages. Only one page is shown at a time and

you can show another page by clicking the tabs in the upper part of the dialog box. The

following pages are available:

· Directories

· Spectrogram

· Wavelet Transform

7.2.1 The Directories Page

The Directories page contains only one setting, the directory for all temporary files

created by Acoustica. You should set this directory path to a directory on a fast hard disk

with sufficient free space. Acoustica works extensively with temporary files and the

speed of the programs depends to a large degree on the speed of the hard disk where the

temporary files are situated.

The directories preferences page
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7.2.2 The Spectrogram Page

You can change the resolution and the color settings of the spectrogram in the

Spectrogram preferences page. You can enter an arbitrary horizontal resolution, but the

vertical resolution is limited to 65, 129, 257, 513 or 1025 pixels (due to the internal

realization using the fast Fourier transform for the advanced reader).

You can choose the color settings from the Color set drop-down list. You can choose

between:

· Color spectrum

· White on black

· Black on white

· Sepia

The spectrogram preferences page

7.2.3 The Wavelet Transform Page

You can change the resolution, the color settings and other properties of the wavelet

transform in the Wavelet Transform preferences page. Both the horizontal and the vertical

resolution in pixels can be set freely.

You can choose the color settings from the Color set drop-down list. You can choose

between:

· Color spectrum

· White on black

· Black on white

· Sepia
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In addition, you can set the frequency range to be analysed in Hertz and the so-called

coherence. A higher coherence value leads to an analysis with better a frequency

resolution on behalf of the time resolution.

The wavelet transform preferences page
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